GUIDELINES for OptEEmAL BIM Input Files

1. Introduction

Within OptEEmAL project, a BIM-based Building Energy Performance Simulation (BEPS) models' generation methodology has been developed, making the BEPS modeling process much more expedient and therefore, less vulnerable to modeling errors.

BIM is an object-oriented digital representation of a building, which encapsulates the information required for generating a BEPS model. Relevant BIM data schemas include the Industry Foundation Classes (IFC) [4] and the green-building XML schema (gbXML). Concerning building geometry, the generic approach of IFC can represent any shape of geometry, while gbXML only accepts rectangular shapes. For this reason, a plethora of recent studies focuses on developing a methodology to automatically generate geometry inputs for BEPS from IFC files. Additionally, IFC appears to be a more suitable choice as its rich content enables interoperability among different software environments and can easily be updated following a building’s life cycle.

However, applying an automated data transformation from IFC to input data of BEPS tools is not a straightforward but a tedious task often due to imperfections of the provided IFC files. Although commercial BIM authoring tools (e.g. Revit™ and ArchiCad™) support exportation of IFC files, their quality is not acceptable in the context of BEPS input data generation. Even Revit™, and its IFC4 Design Transfer View (DTV) exporter, which currently seems to be the most mature tool, is far from being perfect: while IFC schema can capture data about material thermal properties, internal gains (schedules and densities) and 2nd level space boundaries [5], requested from the BEPS perspective, relevant information is missing or incorrect in the exported IFC4 DTV files.

To examine and eliminate these IFC data imperfections, this document aims at presenting the BIM preparation and its IFC data exportation suitable for the OptEEmAL purposes. Since lack of training of the BIM designer contributes to these data imperfections, a set of design guidelines have been developed to help the designer on defining properly all the requested information within BIM (see Section 2).

With the BIM ready, the next stage is the IFC files exportation. However, due to issues mentioned above, the exported IFC file is of poor quality (as for the 2nd level space boundaries information) or lacks valuable information (as for the material thermal properties and internal gains); for the latter, Revit™’s IFC4 DTV exporter has been modified to correctly populate such information (see Section 3).

For the 2nd level space boundaries information, the Common Boundary Intersection Projection (CBIP) tool has been developed [2], where IFC data are enriched with this content. For a successful CBIP tool’s execution, the geometry provided by the IFC file must be of good quality; however, remaining hard-to-discriminate errors, that the BIM designer could not detect following the design guidelines, may occur. Hence, as a post-processing step after the IFC file export, such remaining errors should be detected automatically and corrected manually by communicating the back to the BIM designer. Tools for detecting a wide range of geometric conflicts on IFC data have been developed; commercial solutions for error reporting include the Solibri Model Checker and the TEKLA Model Checker Suite. Although these tools detect various geometric inaccuracies, not all these inaccuracies affect the 2nd level space boundary topology population. Providing the designer with a super-set of errors that do not affect the BEPS geometry information increases the IFC file preparation time without any additional value in the context of the BEPS geometry generation. In fact, the necessity of a tool that detects and reports geometric inaccuracies that affect the generation of the 2nd level space boundary topology only would be preferred. To this direction, the Geometry Error Detection (GED) tool has been developed [1] (see Section 4).

Based on experimental buildings that have been developed in Revit™, this document describes the set of rules that all BIM (IFC4 DTV) files used as input to the OptEEmAL platform should comply to. These rules should be followed by the designer of the BIM files which uses an IFC exporting tool, to ensure that the quality of the BIM files is sufficient for the platforms’ data requirements. Note here that concerning HVAC systems data...
representation, while IFC is the most widely used openBIM schema, it suffers from limitation in the description of HVAC system in the context of BEPS. Commonly, HVAC modelling in BEPS engines require further information than what is available in an IFC file. Hence, the presented BIM design guidelines, are mostly focused on building energy demands estimation aspects.

2. Revit Design Guidelines

To help the BIM designer on creating an error-free (or error-reduced) BIM, from which the maximum level of BEPS information can be exported, a document that presents a set of design guidelines as they apply for Revit™ has been developed – similar guidelines can be developed for other BIM authoring tools. The guidelines follow the data classification introduced in D4.4 [6] (Section 4.3 of D4.4) and are provided as a set of modelling rules belonging to two broad categories: Static and Dynamic Data. Static data rules cover the building geometry, construction materials, glazing information, building services, and so forth, while dynamic data rules cover the specification of time-varying parameters such as occupancy schedules, internal gains schedules, use of equipment, or occupant actions.

First steps in Revit

One of the processes supported by the OptEEmAL platform is the correct placement of the IFC files in the district under investigation to account for neighbor buildings shading effects (neighbor buildings geometry is provided by the district’s CityGML). For a successful execution of this process, the Survey Point and the Project Base Point of the BIM must be placed to the centroid of the building’s footprint, while the building must not later be moved or rotated.

Additionally, the Project Units (Manage -> Project Units) must be defined according to the International System of Units metric system (SI) – at least for the Common and Energy disciplines, while the building elements must be designed using families that come with Revit installation or user defined families that have identical properties’ names with the corresponding Revit families.

Static Data Rules – Geometry, Rooms, Spaces and HVAC Zones

1 Note these guidelines use the Revit definition of terms. This subsection is based on the guideline document and uses a first-person narrative as it is directed to the designer.
The Revit space component is used to store information about the area where it is placed. Space objects store values of parameters that affect the energy simulation. Accurate heating- and cooling-loads simulation can only be accomplished when spaces are created in all areas to account for the entire volume of the building model. Spaces should be defined for each area of the building, including unoccupied areas such as plenums.

A room is a subdivision of a space within a building model, containing elements such as walls, floors, roofs, and ceilings. These elements are defined in Revit as room-bounding and can be used to compute the perimeter, area, and volume of a room. Room objects relate to architectural aspects and are utilised to maintain information about occupied areas, whereas space objects are used predominately for MEP aspects and contain parameters to compute the space area. All spaces (represented as space objects) should be defined in the model, definition of rooms is optional.

HVAC zones comprise one or more spaces that are controlled by equipment that maintains common environmental conditions (e.g., temperature, humidity, and so on). Zones are created to define spaces that have common environmental or design requirements. Spaces that are on different levels can be added to the same zone. Zones are rather important for energy simulations as they define the granularity of the approximation. Grouping spaces into zones in Revit (Analyze -> Spaces & Zones -> Zone) should be done to ensure manageable complexity of the BEPS model. In the case where a space has not been assigned to a zone, a new zone for this space is defined automatically.

Guidelines on how to place spaces are described below, while guidelines for the room’s placement are not defined, since the information that they provide is not used in OptEmAL.

**Guideline 1:** Place spaces in all areas covering the entire volume of your building model. To accomplish this task, open the floor plan, where you want to place a space, from the project browser (see Figure 2). Click the Analyze tab, and under the Spaces & Zones panel click on Space.

![figure2](image)

**Figure 2:** Revit™ 2018 – Reaching the Spaces placement tool

On the Options Bar (see Figure 3), parameters for the space should be specified. Move the cursor into the drawing area and click to place the space. Continue placing spaces or click Modify. You must never Place Spaces Automatically; according to numerous experiments, there are not few cases where the resulting spaces intersect with building elements due to incorrect space boundaries detection.
**Guideline 2:** Following definition of spaces, check using floorplan (Figure 4) and section views (Figure 5) that each space is properly bounded. This means that (1) there are no overlaps between the space volume and the attached building elements, and (2) there are no void volumes (common case when the space volume is not attached to building elements).

Note that from the BEPS perspective, the assumption that each space is treated as a zone could be disastrous in many cases where buildings are larger and the imported BIM models might hold many spaces. Hence, as a first attempt to deal with this issue, the designer could follow the HVAC zones definition presented in ASHRAE 90.1 [3]. For a further number of zones reduction, the designer can reduce the number of HVAC zones based on some similarity between the regions being combined (e.g. similar internal loads). Within OptEEemAL, zones are used only to group spaces that have the same type of energy demand-side system, since details about each individual demand-side system are not provided. For instance, a building that has baseboard heating units installed on all spaces could consist of one zone per level. Additionally, the conditioned and unconditioned spaces must not belong to the same zone. If the same type of energy demand-side system is installed in all conditioned spaces, a simplified zones definition approach is to group all unconditioned spaces in a zone and all conditioned spaces in another zone for each level. Hence, the model should have two different zones per level.
Currently, the modified Revit IFC4 DTV exporter and the transformation process do not consider the condition type defined in Revit, but only the occupiable parameter. Although there is a difference between condition type and occupancy, and an unconditioned space could be occupiable, due to energy demands calculations and limitations of Revit API, unoccupied spaces must be unconditioned. Hence, the designer is strongly suggested to unclick the occupiable parameter for the unconditioned spaces (see Figure 11). This limitation is going to be handled in the next version.

Figure 5 Revit™ 2018 – Check whether each space is bounded correctly in section view

**Static Data – Defining Material Thermal Properties**

A construction must be defined for each building element. Each construction is described by a layer bedding, with each layer corresponding to one material. Two material categories exist: Opaque and Transparent, with the latter being associated with glazing surfaces (windows, glass doors, etc.). Knowledge of material thermal property values is required in the modelling of the various energy transfers – this includes absorbed solar shortwave radiation flux, conduction heat transfer through walls, convective transfer to the space (or outside) air and fraction of sunlight transmitted to building interiors.

Figure 6 Revit™ 2018 – Path to access the construction (material layer bedding) of opaque building elements
For Opaque materials, knowledge of the following thermal properties is required: Thickness, Conductivity, Density, Roughness, Specific Heat, Thermal absorptance, and Solar absorptance. Transparent materials require definition of the following parameters: U-factor and Solar Heat Gain Coefficient (SHGC). In Revit these material properties can be defined by the user and can be subsequently accessed through the Revit API.

To define and retrieve such information the designer must work as follows:

**Guideline 3:** For Opaque building elements (walls, roofs, slabs, etc.), select the building element, click the *Edit Type* button from the properties window and then click the *Edit...* button in the value of structure (see Figure 6).

In the pop-up window, define the material layers and the corresponding thicknesses (see Figure 7).

Finally, for each material layer (row) click the *three dots* button next to the material name and add its thermal properties (see Figure 8 – clicking on “Thermal”, a new tab is added automatically, named Thermal, including representative values of the thermal conductivity, specific heat, density, etc. for the specific material; designer can change these values if necessary).
**Guideline 4:** For glazing building elements (windows, glass doors, curtain walls etc.), select the building component, click the *Edit Type* button from the properties window and choose an *Analytic Construction value* from the predefined list in the pop-up window (see Figure 9).

![Figure 9 Revit™ 2018 – Path to choose an analytic construction’s value for a glazing building element](image)

Most IFC to energy simulation transformation methods currently use construction and material thermal properties of building elements from fixed predefined libraries. This information can be explicitly prescribed in the Revit model, and can also be represented in IFC (e.g. IfcThermalConductivityMeasure for thermal conductivity). Surprisingly, the IFC-exporter is not able to export such information. To overcome such limitation, the REVIT IFC exporter has been modified properly to support exportation of such information. Hence, installation of the OptEEmAL IFC4 exporter is prerequisite.

**Dynamic Data Rules – Internal Gains & Operation Schedules**

Operating building equipment (light and electrical equipment), as well as the presence of people and building infiltration rate, influence the building thermal balance. Each of this contributes to the overall internal gains and can be represented as a time-varying function, called herein schedule. This schedule is called internal gains schedule and is assigned to every building space. Usually the internal gains are estimated based on the maximum value of the internal gain (a building space and the operational schedules for equipment in the same space. The operation schedule of controllable devices plays important role in the calculations performed during simulation. The schedules of controllable devices are determined by either model-based or rule-based control decisions. The IFC schema includes classes for representing the internal gains schedules (IfcTimeSeries). Objects of these classes can be attached to individual space instances. However, concerning the existing BIM-authoring tools, the operating schedules can be selected from predefined variants. In REVIT, such information can be defined in building and/or space scale, following the guidelines below.

**Guideline 5:** Define the Building type, which sets a predefined template for the internal gains (schedules and densities), and the Building Infiltration Class. To achieve this, open the floor plan, click the *Analyze* tab, and under the *Reports & Schedules* panel click on *Heating and Cooling Loads*. In the pop-up window, choose a Value from the list for the *Building Type* parameter and a Value for the *Building Infiltration Class* parameter (see Figure 10).
**Guideline 6:** Define the people, lightings and electric equipment (density and schedule) at each space, selecting the space type, and if the space is Occupiable (see Figure 11). To define the space type, in a floor view, select the space and under the Properties edit the Space Type. When you create spaces, the space type’s Value is <Building Type> by default, which means that the internal gains of the space are defined according to the Building Type (see Guideline 5). However, there are buildings consisting of spaces with different use (e.g. Hotels have rooms and lobbies, to name but a few). In such cases, user should select the proper value for the Space Type for each space of the building.

**Guideline 7:** Parameters of the people, lightings and electric equipment (density and schedule) at each space can be modified by the user (see Figure 12). To modify non-schedule parameters (e.g. Area per Person), set specific values on these parameters. To modify the people’s presence, lightings and electric equipment schedules, click on each Schedule Value and select one of the existing schedules. At this point, we would like...
to mention that the designer must not modify the Factors of an existing schedule, since these schedules have been defined according to relevant standards (ASHRAE 90.1, 2010). If a new schedule is required, the designer must click on the New button (upper-left corner of the pop-up window) and define its Factors properly.

Figure 12 Revit™ 2018 – Definition of operational schedules

3. OptEEmAL IFC4 DTV Exporter

To overcome limitations of the default Revit IFC4 DTV exporter on exporting information about thermal properties of each building entity's construction material and internal gains (schedules and densities), which have been properly set following the aforementioned guidelines, and to guarantee correct exportation of such information, the default exporter (which is an open source component) has been modified to create a bespoke OptEEmAL version that addresses these shortcomings. The OptEEmAL IFC Exporter supports the latest version of Revit™ (2018.3).

Installation

Before installing the proper OptEEmAL IFC4 exporter, make sure that the default Revit IFC-exporter has been uninstalled. To install the OptEEmAL IFC4 DTV Exporter: 1. Download and save the setup program (RevitIFC2018.msi); 2. Once downloading is complete, double-click on the setup file to start the installation.

Exportation Setup

Assuming that the required installation and BIM preparation according to the guidelines have been accomplished, the designer must set the required IFC-exporting options to properly retrieve the information. Guidelines to setup the IFC exportation process are documented below.

Guideline 8: Utilizing REVIT IFC exporter, both spaces and rooms objects are exported as IfcSpaces. As mentioned above, while spaces definition throughout the model is prerequisite, rooms definition is not, since the information that a room object provides is not used within OptEEmAL. Hence, to avoid duplications of IfcSpaces' geometry representation, the user must deactivate the exportation of rooms as IfcSpaces. To this
direction, click the **File** tab, and under the **Export** panel click on **IFC Options**. In the pop-up window, find the **Rooms Revit Category** and set **Not Exported** in the respective **IFC Class Name** (see Figure 13).

![Image of IFC Options in Revit](image)

**Figure 13 Revit™ 2018 – Desabling exportation of rooms as IfcSpaces**

**Guideline 9**: Setting the Rooms as not exported elements, the file is ready to be exported. To do so, click the **File** tab, and under the **Export** panel click on **IFC**. In the pop-up window, the **Current selected setup** must be set to **IFC4 Design Transfer View** (see Figure 14). After that, click on **Modify setup**. In the pop-up window, click on **the Create a new setup based on the selected setup** (lower left corner of the window) and give to the new setup a name (here, **IFC4 Design Transfer View 2**). Click the **Property Sets** tab, select (1) **Export Revit property sets** and (2) **Export IFC common property sets** (if not selected), and push **OK** (see Figure 15). Finally, push the **Export button** (lower right corner).

---

**GUIDELINES for OptEEmAL BIM Input Files** -10-
GUIDELINES for OptEEmAL BIM Input Files

Figure 14 Revit™ 2018 – Exporting the IFC4 DTV file

Figure 15 Revit™ 2018 – Modifying the default IFC4 DTV file exportation

The next shortcoming to be addressed is the geometry errors that affect the 2nd level space boundaries calculation; hard to discern errors that could not be addressed by following the Revit design guidelines and modifying the IFC exporter. There are certain geometric errors that affect the generation of a building energy performance simulation input data file, grouped to the following three categories: clashes; surface errors; and space incorrect definitions.

To help the designer on providing an error-free IFC file in terms of geometry, the previous types of geometric incorrections are detected utilizing the Geometry Error Detection tool (GED). This error detection is performed for every IFC file in the district. If errors exist, they are reported in an XML form (for visualization an OBJ file is generated).

In the case of a clash error, the error is reported as the following XML instance:

```xml
<ClashError id="1" ID_1="25" GID_1="..." ID_2="30" GID_2="...">
  <boundaryRepresentation>
    <surface>
      <outerContour>
        <point3D id="1" x="19.0264" y="3.22" z="8.9999"/>
        <point3D id="2" x="19.0265" y="3.22" z="6.2999"/>
        <point3D id="3" x="18.7062" y="3.22" z="6.2999"/>
        <point3D id="4" x="18.7062" y="3.2199" z="8.9999"/>
      </outerContour>
    </surface>
    ...  
  </boundaryRepresentation>
</ClashError>
```

As displayed in the XML instance above, a clash error report contains the Global IDs (GID) of the two involved entities and the set of surfaces, which define the intersections among the two involved solid bodies, in boundary representation. Every surface consists of an outer and possible multiple inner (holes) 3D point contours. Additionally, at a higher level, clash errors are classified depending on the pair of involved entities. Several types such as Wall-Space, Slab-Space and others exist. Such classification is displayed in the following XML instance.

```xml
<ClashErrors>
  <Wall-Space>
    <ClashError id="1" ID_1="..." GID_1="..." ID_2="..." GID_2="...">...
    <ClashError id="2" ID_1="..." GID_1="..." ID_2="..." GID_2="...">...
    ...  
  </Wall-Space>
  <Slab-Space>
    <ClashError id="1" ID_1="..." GID_1="..." ID_2="..." GID_2="...">...
    <ClashError id="2" ID_1="..." GID_1="..." ID_2="..." GID_2="...">...
    ...  
  </Slab-Space>
</ClashErrors>
```

Inside each clash error category, the clash errors are reported as described previously.

A surface error is reported according to the following XML instance:

```xml
<SurfaceErrors>
  <Site>
    <SurfaceError id="1" ID="1" GID="..." SurfaceNorm="0" NumberOfSurfaces="0"/>
  </Site>
</SurfaceErrors>
```

The XML instance of a surface error contains the IFC GID of the involved building entity, the total number of surfaces of the boundary representation of the involved entity and the total surface norm of its boundary representation, which is the Euclidean norm of the sum of the surface vectors of the boundary representation.
Provided that the total number of surfaces in the boundary representation is greater any divergence of the surface norm from the zero value indicates a surface error. The magnitude of the divergence of the surface norm from the zero value, is proportional to the severity of the surface error.

Finally, a space definition error is reported as displayed in the following XML instance:

```
<SpaceError id="1" SpaceID="3" SpaceGID="2S2HEL_Sn0qeKfEtHTwPb8">
  <boundaryRepresentation>
    <surface>
      <outerContour>
        <point3D id="1" x="-2.4561" y="12.3528" z="0"/>
        <point3D id="2" x="-2.4567" y="12.3543" z="0"/>
        <point3D id="3" x="-2.4567" y="12.3543" z="2.9999"/>
        <point3D id="4" x="-2.4561" y="12.3528" z="2.9999"/>
      </outerContour>
    </surface>
  </boundaryRepresentation>
</SpaceError>
```

As it is presented in previous XML instance, for a space definition error the IFC global id of the internal space is given, together with the boundary surfaces of the space which are not attached to any other building architectural element. The space boundary surface is specified as polygon(s) with outer (and possible inner) 3D point contours.

Errors reported by the GED tool and solution techniques that should be followed depend on a certain building under investigation; hence such solutions could not be part of the general Revit Design Guidelines documentation. However, for the sake of example, the GED tool application on Turina-tower building is illustrated. Turina-tower is one of numerous demo buildings that have been investigated within OptEEemAL project, designed using Revit™ and contained initially several inaccuracies. These inaccuracies affected the generation of the BEPS. In the Appendix, these inaccuracies and solution techniques are presented.

5. References


Appendix

Cases of a Space - Environment surfaces (Geometric error detected by the GED tool)

In all floors of the Turina-tower building certain external walls are missing (exported incorrectly) resulting to missing space boundary surfaces (red colour surfaces).

The external walls of the building are not exported correctly causing undefined space environment surfaces pictured with red color in the figure above. However, according to the guidelines, every internal building space should be surrounded by other architectural elements such as walls, slabs, opening volumes, etc.

To solve the problem with the IFC exporter in Revit (the walls are unexpectedly not present in the IFC file) walls must be unjointed with the rest of elements. If a wall needs to be joined with a column (left) or slab (right) for architectural reasons, a new wall (yellow color) needs to be created, which must be aligned with the existing wall:

Figure 17 Revit™ 2018 – Space - Environment surfaces geometric error correction
Cases of a Space - Wall clashes (Geometric error detected by the GED tool)
In the first floor of the Turina-tower building three spaces pictured below (cyan colored) intersect with surrounding walls (yellow colored). Here, the perimeters of the spaces are not defined accurately causing a space-wall clash.

According to the guidelines, the designer has to specify the boundary of the space in a 2D view manually, by using the command `space separator` and change the perimeter of the space and define it correctly. It is important not to use the automatic space fill tool as it may generate these types of errors.

Cases of a Slab - Wall clashes (Geometric error detected by the GED tool)
In the first floor of Turina-tower building the slab pictured below (green colored) intersects with two walls (yellow colored).
Here the height of the walls OR the level of the slab is not defined precisely causing the wall-slab clash to occur. The designer must adjust either the height of the wall or the level of the slab. In this case, the height of the wall was defined incorrectly:

![Figure 20: Revit™ 2018 - Slab - Wall clashes (Geometric error) correction](image)

**Cases of a Roof - Wall clashes (Geometric error detected by the GED tool)**
In the last floor of the Turina-tower building the roof pictured below (red colored) intersects with four supporting walls (yellow colored).

![Figure 21: Cases of a Roof - Wall clashes (Geometric error detected by the GED tool)](image)

The issue occurs because the roof geometric representation is incorrect or the walls with respect to the roof are misplaced. To solve this issue, we can either use the command Attach Top/Base for join the walls with the roof or create a new slab under the roof and change the height of the walls. In this case the second option is deployed for the several problems existing with the IFC Exporter of Revit (If the command Attach Top/Base is used, the walls do not appear in the IFC file).

![Figure 22: Revit™ 2018 - Roof - Wall clashes (Geometric error) correction](image)

**Cases of a Wall opening - Wall clashes (Geometric error detected by the GED tool)**
In the last floor of Turina-tower building the wall openings pictured below (cyan colored) intersects with their walls (yellow colored).
CBIP tool subtracts the opening volumes from the wall elements of the model. However sometimes the walls with their opening volumes subtracted intersect with other opening volumes, which are not subtracted, due to several reasons (see A, B and C cases in the figure above):

A. The door/window frames are thicker/thinner than their walls. In this case the opening volumes are extended beyond the boundaries of their walls.

B. Two or multiple openings are placed in the position of one opening. (This is also a Wall opening - Wall opening clash).

C. The opening is not associated to its respective wall. In this case CBIP does not subtract the opening from the wall and a clash occurs.

To solve these issues, in case A: the problem with the family must be resolved, in this case the door; in case B: one of the openings must be deleted; and in case C: solution is similar with case A issue’s solution, but the problem is with the opening cut of the family.

*Cases of a Slab opening - Wall clashes (Geometric error detected by the GED tool)*
In the second floor of Turina-tower building the slab opening pictured below (cyan color) intersects with neighbor walls (yellow color).
This issue occurs because the height of the walls is bigger than the height of the slab or the slab is placed lower than the upper surface of the walls. This clash is also associated to a wall-slab clash. In this case, the height of the walls was correct but there was a problem with the dimension of the walls. The dimension of the walls should be modified, and the slab opening changed for a new definition of the perimeter inside the slab: